Automate Network Changes

This section contains the following topics:

* Change Automation Overview, on page |

 About Custom Plays, on page 5

» About Customizing Playbooks, on page 11

» About Running Playbooks, on page 19

* Use the Change Automation Dashboard, on page 42
* Troubleshoot Change Automation, on page 44

Change Automation Overview

The Change Automation application automates the process of deploying changes to the network. You can
define automation tasks to achieve the intended network states in Change Automation using Playbooks that
consist of Plays written using YAML. You can then push configuration changes to Cisco Network Service
Orchestrator (NSO), which deploys these changes to the network devices.

Change Automation, in conjunction with health insights, allows operators to build automation in a closed-loop
framework. Changes are deployed to the router or other device using programmable APIs, and the intent of
the change is verified using telemetry that comes back from the router. Change Automation relies on telemetry
to verify the intent of the change, avoiding the need to frequently poll the device for updates.

The following is a high-level Change Automation workflow:

1. Review the existing Plays and Playbooks to see if they fully or partially meet your needs.

)

Note Change Automation comes with a robust library of Playbooks, each with its own collection of configuration
and check Plays.

2. Build Playbook as required:

« If the required Playbook is available, use it.
* [f some combination of existing Plays accomplishes the task, build a new Playbook using those Plays.

« If some of the required Plays are not available, create new Plays and build a new Playbook using the
new and existing Plays.
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. Configure Change Automation Settings

3. Dry run the Playbook to test if it performs as expected.
4. Deploy the Playbook.

Change Automation allows you to customize and generate Plays and Playbooks using its API interface. For
more information, see About Custom Plays, on page 5 and About Customizing Playbooks, on page 11.

Configure Change Automation Settings

Configuring Change Automation settings is a post-installation activity and is the first task to be performed
after installing Change Automation.

For more information, see Configure Change Automation Settings.

View the Play list

The Play List window of the Change Automation application gives you a consolidated list of all the Plays in
the system.

From the main menu, select Network Automation > Play List to view the Play List window.

Figure 1: Play List
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Name Description (ipe Labels Modified By ™\ Last Modified
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10S XE | | cisco-ios-cii-6.33

Add VRF under BGP on.. (@  Play to add a VRF under BGP on a router Device Config Cisco 23-0ct-2020 05:28:00 AM IS1
Add or delete Ethernet @  Play adds interfaces to or deletes interfaces from an existing Ethernet link bu..  Device Config B8 ko) Cisco 24-Aug-2022 02:35:00 AM IS”
Add or remove VRFun.. (D Play to add or remove VRF under BGP on router Device Config E) Cesnannizld Cisco 01-0ct-2020 04:55:00 AM IST
Add orremove anaddr.. (D  This play adds or removes an IPv4 address family under either a global BGP o...  Device Config D) Ceacanninzy Cisco 08-0ct-2020 05:23:00 PM IST
Add prefix list to the ro.. @ Play to configure a new prefix-list and also can be used to modify the existing... Device Config ) (e Cisco 27-0ct-2020 07:11:00 PM IST
Add/Delete prefix seto.. (@ This play creates a new or modifies or deletes an existing prefix set on a spec... Device Config D) Eesakacidd Cisco 01-0ct-2020 04:41:00 PM IST

O Add/Remove Traffic col.. @  Play to add or remove traffic collector on a XR router Device Config 2D € EEmEasE2 cisco 22-0ct-2020 11:12:00 AM IST
Capture and comparen... (@ Play to capture node states based on the given sensor path and reports the d...  Action &) (Gack Cisco 22-0ct-2020 06:23:00 AM IST
Change interface state.. (&  Shut or unshut one or more interface on an XR router Device Config 2ER) (hoogioaxielin2d) Cisco 04-Nov-2020 01:17:00 AM IST

0 Change interface state @ Play to change the GigE interface state on a 10S XE router Device Config 2D G Cisco 22-0ct-2020 12:57:00 PM IST
Check BGP neighbor st.. (@ Play checks the state of the given BGP neighbor and passes if the state is ES.. ~ Check (SHME Cisco 23-0ct-2020 02:15:00 AM IST
Check CPU usage @  Verify that CPU utilization on the target device is below the reference thresho... ~ Check i Cisco 23-0ct-2020 01:58:00 AM IST

] Check VRF neighbors s. @ This verb uses the collector golang library and generic CLI collection (*sh bg. Action D) G5 Cisco 23-0ct-2020 05:44:00 AM ST
Checkif the trafficispr.. (@ Play to invoke the generic cli collection for "show traffic-collector ipv4 count. Action D EED & Cisco 29-Jan-2021 08:49:00 AM IST —
Checkiinterface bandw... @  Play uses MDT to see if the interface bandwidth is greater than or equal toa .. Check (L Cisco 23-0ct-2020 02:13:00 AM IST %
Check router interface .. (@ Play MDT to check the Line State of all the interfaces. It passes if the Line Sta...  Check (57 Cisco 23-0ct-2020 02:06:00 AM IS1 §
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Item Description

Click @ to create a custom Play. See Create a Custom Play Using Templates, on page 5.

Click = to delete a custom Play. See Delete Custom Plays, on page 10.

Click \=J to import a custom Play from a gzipped TAR archive file. See Import Custom Plays,
on page 10.

Click =) to export a custom Play as a gzipped TAR archive file. See Export Plays, on page 9.

2 Click Dto see a pop-up Play Details window showing the Play's description and schema. When
you are finished viewing these details, click X or the Close button to close the pop-up window.

3 The Type column indicates the type of the Play. You can click the column headings (Name,
Description, Type, Labels, and Modified by) to sort the table using that column's data.

4 Click 13 to refresh the Plays list.

5 Click = to set filter criteria on one or more columns in the table.

Click ® to clear any filter criteria you may have set.

View the Playbook List

The Change Automation application's Playbook List window (in the following figure) gives you a consolidated
list of all the Playbooks in the system. To view the Playbook List window, select Network Automation >
Playbook List.
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Figure 2: Playbook List
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Name

Version Software Platform Modified By Last Modified Labels

‘7 ) ) ) | ) C——

Add Prefix Listto X... (@ ADD prefix-list to a XE router or add prefixes to existing prefix-list 100 105 XE Cisco 28-0ct-2020 12:00:56 P... ' stock
O Add VRF under BGP.. (D Add VRF under BGP on a XE router 100 105 XE Cisco 28-0ct-2020 02:43:32 P... ' stock
Add/Remove VRFu.. (D Addjremove VRF under BGP instance on XR router 100 105 XR Cisco 01-0ct-2020 04:59:24 A stock
Check accessibility .. @ Check ip accessibility to router and JsonRpc accessibility to its mana... 1.0.0 10S XR,I0S XE Cisco 21-Jan-202106:53:41 AM... | stock
O Compute the traffic.. (@ This playbook computes the impact on the network if a node or interf... 1.0.0 108 XR Cisco 03-Nov-2020 06:12:31 A. stock
Computing path wit.. @  This playbook computes a path from source to destination with SR a...  1.0.0 108 XR Cisco 03-Nov-2020 06:16:34 A... ' stock
Configure ISiS onth.. @  Configure ISIS on the designated router 100 105 XR Cisco 02-0ct-2020 06:04:46 P... ' stock
0O Configure ISISonth... @  Configure ISIS on the designated XE router 1.00 108 XE Cisco 28-Oct-2020 03:12:46 P. stock.
Configure OSPF pro.. (D  Configure OSPF on a XR router 100 105 XR Cisco 03-Nov-2020 06:32:43 A... ' stock
O Configure route poli @ Configure route policy on a router 1.00 108 XR Cisco 01-Oct-2020 04:33:08 A. stock
O Create bgp neighbo. @  Create BGP neighbor on a XE router 1.00 108 XE Cisco 28-0ct-2020 03:43:49 P. stock.
Create Bundle Ethe.. (D Create a Bundle Ether and add interface to the bundle 100 105 XR Cisco 21-Jan-202102:34:29 A... ' stock
m] Create/Delete static. (@ Create/Delete static routes on a XR router 1.00 108 XR Cisco 18-Feb-202102:36:45 A, stock
Create/Update VRF .. (D Creates a new VRF config 100 108 XE Cisco 28-0ct-2020 04:52:48 P. stock
Createfupdate/delet.. (D Creates a new VRF or updates/deletes an existing VRF configonan...  1.00 105 XR Cisco 01-0ct-2020 05:40:23A... ' stock %
DeleteaSMUoran.. (@ Delete a SMU or an optional package from the SWIM repository. 100 105 XR Cisco 17-May-2022 05:19:27 A stock %
Delete ACL basedtr.. (D Delete the segment routing policy and ACL traffic steering configurat... 1.00 108 XR Cisco 03-Feb-202108:41:35 A stock UN;

Item

Description

Click @8 to create a custom Playbook. See Create a Custom Playbook Through the UI, on page
11.

Click = to delete the currently selected custom Playbook. See Delete Custom Playbooks, on
page 18.

Click (=J to import Playbooks from a gzipped TAR archive file. See Import Playbooks, on page
18.

Click =] to export the currently selected Playbook(s) as a gzipped TAR archive file. See Export
Playbooks, on page 17.

Click Manage L abelsto assign a label(s) to the Playbook. Assigning label(s) to the Playbooks
allows the system administrator to control which Playbooks each user role is allowed to run.

Click Dto see a pop-up Playbook Detailswindow showing the Playbook's description, software
compatibility, version number, and its plays. When you are finished viewing these details, click
X or the Close button to close the pop-up window.

Click the Name, Description, Version, Software Platform, and L ast M odified column headings
in the table to sort the table by that column's data. You can also choose which columns are shown
and set quick or advanced filters for any column.

Click 2 to refresh the Playbooks list.
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Item Description

6 Click = to set filter criteria on one or more columns in the table.

Click ® to clear any filter criteria you may have set.

About Custom Plays

Change Automation allows you to create your own custom Plays, either based on Cisco models or from
scratch. You can also import, export, and delete your custom Plays.

You can create custom Plays in any of the following types:

» Check Play: Verifies the data from your devices using a logical expression.
« Data Collection Play: Collects data from your devices.
* Device Config Play: Performs configuration changes on your device

« Service Play: Provisions and manages a service that is deployed.

Note  You cannot edit, export, or delete Cisco-supplied Plays.

Note Check Play and Data Collection Play supports MDT and SNMP collection.

Create a Custom Play Using Templates

This section explains the procedure to create a custom Play. The stages of Play creation vary depending on
the Play type you choose:

» Check Play: Select Play Type > Select Sensor Path > Build Check Expression > Review Play
« Data Collection Play: Select Play Type > Sdlect Sensor Path > Build Filter Expression > Review Play

« Device Config Play or Service Play: Select Play Type > Configure Play (using sample payload in JSON
format) > Review Play

Step 1 From the main menu, choose Network Automation > Play List. The Play List window is displayed.

Step 2 Click & to create a custom Play. The Select Play Type window opens displaying the types of Plays supported and a
description for each. The stages of creation are also displayed, and it varies depending on the Play type you select.
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Step 3

Create a Custom Play Using Templates

Figure 3: Select Play Type

Select Play Type

Check Play

|Generate a play to verify data from routers
using a logical expression. This play
supports MDT, SNMP and CLI collection.

Cancel

Select Type Sensor Details

Data Collection Play

Generate a play 1o collect data from
fouters. This play supports MDT, SNMP
and CLI collection.

o o

Build Check

Device Config Play

Generate a play Lo perform configuration
changes on a device using tailf sample
payload as a template.

Select the Play type that you want to create and click Next.

Creating a Check Play or Data Collection Play

Review Play
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[</>]
Service Play

Generate a play 1o provision and manage a
service in NSO using a sample service
provision payload as template.

When creating Check or Data collection plays, Cisco provides YANG modules for Cisco products. The process that is
described in this section assumes that the sensor that you want to use or the field that you want to modify is included in
the modules that are provided by Cisco. If the sensor or field is not listed in the default YANG modules, Cisco allows
you to expand the device coverage. For information on loading a new or modified module, see the topic Manage Device
Packages in the Cisco Crosswork Network Controller Administration Guide.

a) In the Select Sensor Paths window, select the required YANG module, Gather Path, and Sensor Paths. Click Next

to continue.

Figure 4: Select Sensor Paths

Select Sensor Paths™

YANG Modules

Module

Gather Paths

Gather Path

(

Sensor Paths

CISCO-AAA-SERVER-MIB
CISCO-AAA-SESSION-MIB
CISCO-ACCESS-ENVMON-MIB
CISCO-AUTH-FRAMEWORK-MIB
CISCO-BGP-POLICY-ACCOUNTING-MIB
CISCO-BGP4-MIB
CISCO-BULK-FILE-MIB
CISCO-CBP-TARGET-MIB
CISCO-CCME-MIB

CISCO-CDP-MIB

CISCO-CEF-MIB.
CISCO-CLASS-BASED-QOS-MIB

CISCO-CONFIG-COPY-MIB

Cancel

CISCO-AAA-SERVER-MIB:CISCO-AAA-SERVER...

CISCO-AAA-SERVER-MIB:CISCO-AAA-SERVER...

CISCO-AAA-SERVER-MIB:casServerStateChang...

CISCO-AAA-SERVER-MIB:casServerStateChang

CISCO-AAA-SERVER-MIB:casServerStateChang

CISCO-AAA-SERVER-MIB:CISCO-A...  ipv4-address

CISCO-AAA-SERVER-MIB:CISCO-A... counter32
CISCO-AAA-SERVER-MIB:CISCO-A...  int32

CISCO-AAA-SERVER-MIB:CISCO-A...  counter32
CISCO-AAA-SFRVFR-MIR:CISCO-A  counter3?

casProtocol,casindex
casProtocol,casindex
casProtocol,casindex
casProtocol,casindex

casPratacol casindex

casAddress
casAuthenincorrectResponses
casAuthenPort

casAuthenRequestTimeouts

Sensor Path Type Keys Field Name
0 ) ) )
[ c1SCO-ARA-SERVER-MIBICISCO-A... counter32 casProtocol,casindex casAcctincorrectResponses
[ CISCO-ARA-SERVER-MIBCISCO-A...  int32 casProtocol,casindex casAcctPort
() CISCO-AAA-SERVER-MIBICISCO-A... counter32 casProtocol,casindex casAcctRequestTimeouts
[)J  CISCO-AAA-SERVER-MIB:CISCO-A...  counter32 casProtocol,casindex casAcctRequests
[[)  CISCO-AAA-SERVER-MIB:CISCO-A... Timelnterval casProtocol,casindex casAcctResponseTime
[ C1SCO-AAA-SERVER-MIBCISCO-A... counter32 casProtocol,casindex casAcctServerErrorResponses
[ CISCO-AAA-SERVER-MIBICISCO-A...  counter32 casProtocol,casindex casAcctTransactionFailures
() CISCO-AAA-SERVER-MIBICISCO-A... counter32 casProtocol,casindex casAcctTransactionSuccesses
[ CISCO-AAA-SERVER-MIB:CISCO-A...  counter32 casProtocol,casindex casAcctUnexpectedResponses.
O
O
]
m]
m

casAuthenReauests

b) Depending on the Play type you have selected, you must Build Check (for Check Play) or Build Filter (for Data
Collection Play) to apply in your Play. Click Add Ruleto add a logic expression using the keys and fields of the
selected sensor path(s). Click Add Group to add a new logic group. Select the sensor field, operator, and value from
the drop-down lists. Select the desired logic operation (AND/OR) between each rule or group.
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Step 4

Create a Custom Play Using Templates .

Click the Runtime check box if you prefer to enter the value of the sensor field dynamically during run time. If you
select this check box, the value field is disabled, and you will be prompted to enter the input parameter when this

Play is executed (as part of a Playbook) during run time.

Figure 5: Check Expression

Check Expression
Build check expression using the selected fields.

A ] or

t [setect sensor eta v (setectoperator | (

+ [and] or

[Ss/@crrsncmﬂpr‘c v] [Sﬂ!@cropﬂratm v

Cancel

Click Next to continue.

Creating a Device Config Play or Service Play

Add Rule Add Group

Ensure that the configuration you are trying to create is available in NSO; otherwise, it will show an error.

When creating a Service Play, you are not creating a new service for NSO but creating a Play to manage and provision
an existing service in one or more NSO instances. For more information, see https://developer.cisco.com/docs/nso/.

a) In the Configure Play window, click \=J or the Import link to import your device config (JSON) file. You can

download and use the sample configuration template. Browse and select your .JSON file, and click Import.

b) In the acknowledgment prompt, click Continueto select the NSO instance for the config you have imported.
¢) Select the NSO provider instance from the dialog box and click Process Payload.
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. Create a Custom Play Using Templates

Figure 6: Select NSO Provider

Select NSO Provider

d)

Select the managing NSO instance from the list below and ensure that HTTPS connectivity is enabled to the NSO instance. Then,
Click "Process Payload button to view "Config" schema.

Providers
Reacha... State Provide... uuiD Con... Family Type Model P... Model V...
(2 I ™ B G N B ™2 B G I G I G I
® o "y nso101 (@ ¢59b32f0.. NETC.. NSO Cisco-I0... 6.6.1;6.9.2

Cancel Process Payload

Note
payload file used.

The creation workflow of a Service Play is similar to the Device Config Play, except in the template of the

The Configure Play window opens, displaying information from the payload file. You can edit the value or description

columns with the values that you want to see during a Playbook execution.

Figure 7: Configure Play

Collapse All

Title
 tailf-ncs:devices
 device
o
name
 config
v I
tailf-ned-cisco-ios-xrinterface
Y i
GigabitEthernet-subinterface
 GigabitEthernet
o
id
mode
description
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" encapsulation

v

Cancel

Select Type

Beautify Table

Value

xrvok-1

0/0/0/0.401
12transport
T-SDN Interface

64

Configure Play

Path
Jtailf-ncs:devices

Jtailf-ncs:devices/device

Itailf-ncs:devices/device/0/name

[tailf-ncs:devices/device/0/config

/
GigabitEthernet-subinterface

winterface

“interface/

face/

Type

container
container
container

list

string
string
string
uint16

container

o)

Review Play

Description

NCS copy of the device configuration

Select an interface to configure

Set description for this interface
Set the MTU on an interface

Set the encapsulation on an (sub)interface

Actions

kY BY

Previous m
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Step 5

Step 6

Export Plays .

Click Next to continue.

In the Review Play window, review the parameters of your Play. Click Dry Run to validate your parameters.

Label your Play with a unique Name and Description.

Note Cisco also formats the play names with indicators such as cfg for configuration, chk for check, and so on, in the
name to help you organize the plays properly. You can also use similar tagging for the plays you create.

You can also add labels to your Play to group it in the future (optional).

Note The labels determine the type of devices with which you can use the Play. For example, an IOS XR Play cannot
run on I0S XE devices. Be sure to review the labels (I0S XR, IOS XE, and so on) when you add them.

Figure 8: Review Play

Review Play Label your Play

Sensor Details Change —_—
Name* ©

Module CISCO-AAA-SERVER-MIB

y RVER-MIB/casConfi

Description* ©

Cadence* © 120 ‘

Labels ]

Check Logic Change
Expression (“casprotocol’ == "radius* |

If you are satisfied with your changes, click Create.

The Play List window opens, displaying your new custom Play in the Play list.

Export Plays

Step 1
Step 2

A user must have Change Automation read permission to export any custom Play authored or imported by
you or another user into Change Automation.

The exported archive contains only the user-customizable files listed in Playbook Components and Files, on
page 11. Once you extract them from the archive, you can identify the Play components by their file names
and filename extensions.

From the main menu, choose Network Automation > Play List.

Check the check boxes for the custom Plays you want to export.
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. Import Custom Plays

Step 3 Click (%), Your browser will prompt you to select a path and the file name when saving the gzipped tar archive. Follow
the prompts to save the file.

Import Custom Plays

You can import any custom Play that meets the following requirements:

* The Play files must be packaged as a gzipped tar archive.
* The archive must contain a . play file (a data spec file for the Play), at minimum.

* The archive file must have a unique name.

)

Note For more details about editing and importing, see Cisco Crosswork Change
Automation Developer Guide.

You can overwrite a custom Play. The system will warn you when you are about to overwrite a custom Play
but will not prevent you from doing so.

A

Warning  Take precautions to ensure you do not accidentally overwrite the custom Plays you created.

Before you begin

To import Plays, a user must have write access. For more information about granting a user read-write role
access, see Configure Change Automation Settings.
Step 1 From the main menu, choose Network Automation > Play List.

Step 2 Click . Your browser will prompt you to browse to and select the gzipped archive file containing the Plays you want
to import.

Make sure that there are no Cisco-supplied Plays with the same name as the Play you intend to import. If you import a
Play with the same name, it will fail.

Step 3 Follow the prompts to import the archive file.

Delete Custom Plays

You can delete custom Plays only. You cannot delete a Cisco-supplied Play.

Your user ID must have Change Automation delete permission to delete Plays.

Step 1 From the main menu, choose Network Automation > Play List.
Step 2 In the Play List window, select the custom Plays you want to delete.
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Step 3 Click the = icon.
Step 4 When prompted, click Delete again to confirm.

About Customizing Playbooks

You can create your own Playbooks from scratch, based on details from Cisco-supplied Playbooks. You can
also create custom Playbooks using the available Plays.

Creating and modifying Cisco-supplied Playbooks are engineering tasks that take place outside of the user
interface for Change Automation. As such, they are outside the scope of this User Guide.

Cisco supplies developer-level documentation for Cisco-supplied Playbooks. For more information on how
to create custom plays and Playbooks, see the:

* "Playbooks" and "Plays" references in the Change Automation Developer Guide on Cisco Devnet

* "Custom Playbooks" tutorial in the Change Automation Developer Guide on Cisco DevNet

Playbook Components and Files

Change Automation Playbooks contain various components, referred to using specialized names. The
components are implemented in the Playbook as files. Some of these components' names are borrowed from
the Ansible specification, but all have their definitions, and not all the corresponding files can be customized
by users. Some components are Cisco proprietary intellectual property; while you can use them in custom
Plays and Playbooks, you cannot customize them directly. For more information, see Section: Writing Custom
Playbooks at Cisco Crosswork Change Automation Developer Guide.

Create a Custom Playbook Through the Ul

Change Automation allows users with admin and read/write roles to create custom Playbooks using the
available Plays. For more information about granting read/write role access to a user, see the section "Assign
Change Automation User Access Levels" in the topic Configure Change Automation Settings.

)

Note You cannot edit a custom Playbook once it is created. We recommend that you perform a dry run of the
Playbook before completing the creation to ensure that the Playbook's purpose is met. Once created, if you
must make changes to the custom Playbook, you have to recreate your Playbook with the relevant changes.

Step 1 From the main menu, choose Networ k Automation > Playbook List. The Playbook List window is displayed.

Step 2 Click @ to create a custom Playbook. The Select plays window opens displaying the available Plays.
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. Create a Custom Playbook Through the Ul

Step 3

Figure 9: Select plays

. o o o
Select Plays Order Playbook Configure Plays Review Playbook

Available Plays Selected 0/ Total 62 1)

Name Type Play Id Labels Description Modified By Last Modified

\ ) ( V] ) ) ( ) )
] Add VRF under BG..  ® Device Config router_cfg_bgp_vrf xe  IOSXE | cisco-ios-cli-633  Play to add a VRF under BGP on a router Cisco 23-0ct-2020 05:28:00 A
] Add or delete Ethe. @  Device Config router_cfg_modify_b. I0SXR , cisco-iosxr-cli-7.29  Play adds interfaces to or deletes interfaces from an existing Ether. Cisco 24-Aug-2022 02:35:00 A.
O Add or remove VRF..  (©  Device Config router_cfg_bgp_vrf I0SXR , cisco-iosxr-cli-718 . Play to add or remove VRF under BGP on router Cisco 01-0ct-2020 04:55:00 A..
] Add or remove an @®  Device Config router_cfg_bgp_addr..  I0SXR | cisco-iosxi-cli-729 This play adds or removes an IPv4 address family under either agl... ~ Cisco 08-0ct-2020 05:23:00 P.
] Add prefix listtoth.. @ Device Config router_cfg_prefix_list..  10SXE , cisco-ios-ci-6.33  Play to configure a new prefix-list and also can be used to modify t... ~ Cisco 27-06t-2020 07:11:00 P...
] AddDelete prefixs.. @ Device Config router_cfg_prefix_set ~ I0SXR , cisco-iosxr-cli-218  This play creates a new or modifies or deletes an existing prefix se... ~ Cisco 01-0ct-2020 04:41:00 P.
O Add/Remove Traffi.. (@ Device Config router_cfg_traffic_co. I0SXR (SR, cisco-iosxr-c Play to add or remove traffic collector on a XR router Cisco 22-0ct-2020 11:12:00 A.
O Captureand comp... @  Action router_op_state_sna...  CLI, Check Play to capture node states based on the given sensor path and re...  Cisco 22-0ct-2020 06:23:00 A.
] Change interfaces.. @  Device Config fouter_cfg_interface. 10SXR |, cisco-loswr-cli-724  Shut or unshut one or more interface on an XR router Cisco 04-Nov-2020 01:17:00 A
@] Change interface .. (© Device Config router_cfg_interface...  10SXE , cisco-ios-ci-633  Play to change the GigE interface state on a I0S XE router Cisco 22-0ct-2020 12:57:00 P.
(] Check BGP neighb. @ Check router_chk_bgp_neig. SBLD Play checks the state of the given BGP neighbor and passes if the Cisco 23-0ct-2020 02:15:00 A.
O Check CPU usage @ Check router_chk_cpu_proc. P Verify that CPU utilization on the target device is below the referen...  Cisco 23-0ct-2020 01:58:00 A.
a Check VRF neighb... ~ ©  Action router_op_verify_vrf_..  CLI, Check This verb uses the collector golang library and generic CLI collecti...  Cisco 23-0ct-2020 05:44:00 A.
] Check if the traffic @ Action router_op_verify_traf. CLI , Check , SR Play to invoke the generic cli collection for "show traffic-collector i Cisco 29-Jan-2021 08:49:00 A.

[ 1o |
Select all the Plays you want in your Playbook, and click Next.
Note The recommendation is to include the Perform Check Sync on the device and Sync NSO from device Plays as

a pre-step to running other operations in the Playbook or as part of pre-maintenance.

The Perform Check Sync on the device Play checks the device sync status with NSO and performs sync only when
needed, based on the Playbook's sync parameter value. It reduces the playbook execution time and ensures the NSO
configuration matches the device configuration.

« If the Playbook's sync parameter is set to True and the device is not in sync, the Perform Check Sync on thedevice
Play will sync the device with the NSO configuration.

» [f the sync parameter is set to False and the device is not in sync, the Play will fail to execute with a commit message.

* [f the device is already in sync, the Play will succeed.

In the Order Playbook window, arrange the order of the Plays in the Playbook as per the execution phase (Continuous,
Pre-Maintenance, Maintenance, Post-Maintenance). By default, all the selected Plays are displayed within the Maintenance
phase. You can click and drag the Plays to rearrange them to the appropriate phase.

Depending on the type of Play you have selected, it may be restricted from being used in certain phases. For example, a
configuration Play cannot be used outside of the Maintenance phase.

For more information on each execution phase, see Playbook Execution Order, on page 20.

Change Automation also formats the Play names with indicators such as "cfg" for configuration, "chk" for check, and so
on, in the name to help you organize the plays properly. You can use similar tagging for the Plays you create.

You can also duplicate or delete a Play by clicking on the icons provided.
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Figure 10: Order playbook

N

Create a Custom Playbook Through the Ul .

o o
Select Plays Order Playbook Gonfigure Plays Review Playbook
Plays © Play Schemas ©
[ > continious | [ continous |
< Maintenance

¢ router_chk_bgp_neighbor_state

% router_cfg_interface_state_xe

% router_chk_interface_mdt

Name: Check BGP neighbor state

Name: Change interface state to up/down onal.

Name: Check router interface Line State using M

a

a

a

< Maintenance

Check BGP neighbor state
Change interface state to up/down on a I0S XE router

Check router interface Line State using MDT

[ > Post Maintenance

> Post Maintenance

Click Next.
Step 4

Figure 11: Configure plays

Specify Registers, Conditionals and Policy ©

Select Plays Order Playbook

Configure Plays

The Configure Plays window opens, displaying the Plays in each execution phase and the Play schemas.

o

Review Playbook

Play Schemas ®

> Continuous

| [ > comiuous

< Pre Maintenance

¢ router_chk_bg Name

Check BGP neighbor st

< Maintenance

¢ router_cfg_int Name

Change interface state

< Post Maintenance

¢ router_chk_int Name

Check router interface |

< Pre Maintenance

Check BGP neighbor state
View «

v object {8)
id

r_chk_bgp_neighbor_:
type  object

title : Check BGP neighbor state

$schema : http:/fjson-schema.org/draft-06/schemat#
required [1]

v v

properties (1}

description : Play checks the state of the given BGP neighbor and passes if the state is
ESTABLISHED. If the state is any other value, the check fails
additionalProperties : false

Cancel

You can perform the following:

[ > Post Maintenance ]

« Click &2 to specify a policy for a Play. In the Specify Policy dialog box, specify relevant values for the fields

provided. Click ® for more information about each field. Click Save to save your policy values.

Note Policies are applicable to Check Plays.
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Figure 12: Specify Policy

Specify Policy

Security () consecutive ®

cancel m

« Click £% to apply a condition to a Play. Execution of the play proceeds only if the condition is met. In the Specify
Conditionals dialog box, click Add Condition to add a condition. Click Save to save your conditional values.

Figure 13: Specify Conditionals

Specify Conditionals

Build conditionals using the selected fields. Add condition

Cancel m

« Click [ to specify a register for a Play. Specifying registers allows you to use the output of a previous Play as the
input for another Play. Click Save to save your registers.

Figure 14: Specify Registers

Specify Registers

Specify registers using the selected fields:

config |

* (Optional) Rename the Plays if you want them to be displayed with different names during the Playbook execution.

Click Next to continue.
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Step 5 In the Review Playbook window, review the Plays in your Playbook. Enter relevant values for the Playbook details

fields. You can click @ for more information about each field.

Figure 15: Review Playbook

Select Plays Order Playbook Configure Plays Review Playbook

Review Plays Playbook details
< Pre Maintenance
Check BGP neighbor state
Change interface state to p/down on 108 XE route Prerequisites :]
< Post Maintenance
Run | Schedule Permissions
Check router interface Line State using MDT
Manage Roles
o

Note For the Software Platform(s) field, make sure to use the exact software type name as it is mentioned in Device
Management > Network Devices > Software Type column.

Step 6 (Optional) Click Select and perform one of the following, as applicable, to set the L abels:

* Select the applicable label and click Done.
* Click + New label, enter relevant values for Label and Roles, and click Save. Select the new label and click Done.

Note The labels determine which user or roles can run which Playbooks.

For more information on assigning Playbooks to specific roles, see Assign Playbooks to Specific Roles, on page
19.

Step 7 (Optional, but recommended for testing the Playbook) After you enter the relevant details, click Dry run to validate the
parameters. A dialog box opens, displaying the Playbook Details.
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Step 8
Step 9

Create a Custom Playbook Using APls

Figure 16: Playbook Details

Playbook Details: trial

The following playbook will be created

trial
Last Modified: 2023-Nov-16, 18:30:10 by admin

Software Platform: I10S XR  £Version: 1.0

Description: test
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> Continuous (0)

< Pre Maintenance (1)

1 Check BGP neighbor state

< Maintenance (1)

2 Change interface state to up/down on a IOS XE router

< Post Maintenance (1)

Note

the parameters you entered.

Cancel Create Playbook

Dry run does not commit the changes but provides a platform to validate whether the Playbook would work with

Click Previousto navigate back to a step to make changes as necessary to get the Playbook to function properly.
Click Create to create the Playbook.

The Playbook List window opens, displaying your new custom Playbook on the list.

This section explains the steps to create a custom Playbook using APIs. For more information, see the "Custom
Playbooks" tutorial in the Change Automation Developer Guide on Cisco DevNet.
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Step 1

Step 2

Export Playbooks .

\)

Note A Playbook containing a custom Play can be created through the UI (see Create a Custom Playbook Through
the UI, on page 11) or using APIs.

A Playbook consisting of one or more custom Plays is expected to have a dataspec value for the custom Play
in the Playbook file. The dataspec value is generated when the custom Playbook is created using the API in
this procedure. You cannot create the same custom Playbook using the import option (API: /vl/mops/import),
as it does not add the dataspec value for the custom Play.

Ensure that the Plays (stock or custom) you need for the Playbook are created beforehand.

You can create a custom Play either through the UI (see Create a Custom Play Using Templates, on page 5) or using
API (use the API call //crosswork_ip:30603/crosswor k/nca/vl/Plays/device/config).

Note If you are importing Plays that share the same name with existing Plays, then the error "Play validation
failed, custom Play already present" will be displayed, to prevent the existing Plays being
overwritten.

Create the Playbook using the following API:
API call: //crosswork_ip:30603/crosswor k/nca/vl/mops

Export Playbooks

Step 1
Step 2
Step 3

Step 4

You can export any Playbook as a gzipped tar archive. This includes any Cisco-supplied Playbook and custom
Playbooks you or another party have authored and imported into Change Automation.

The exported archive contains only the user-customizable files listed in Playbook Components and Files, on
page 11. It also contains one or more . pb files (for example, router config bgp rd.pb for the
Playbook code), which are parsed and processed at the back end.

You can edit the exported files as needed, following the guidelines in the "Custom Playbooks" tutorial in the
Change Automation Developer Guide on Cisco DevNet. Then, you can import them as explained in Import
Playbooks, on page 18.

Your user ID must have Change Automation read permission to export Playbooks and write permissions to
import new or modified playbooks.

From the main menu, choose Network Automation > Playbook List.

(Optional): In the Playbook List window, filter the table as needed.

Check the check boxes for the Playbooks you want to export. Check the check box at the top of the column to select all
Playbooks for export.

Click (2. Your browser will prompt you to select a path and the file name when saving the gzipped tar archive. Follow
the prompts to save the file.
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Import Playbooks

You can import any custom Playbook, provided it meets the following requirements:

* The Playbook files must be packaged as a gzipped tar archive.
* The archive must contain a . pb file, at minimum.

* The archive file must have a unique name.

The individual files included in the archive must meet the additional validation requirements described in the
"Custom Playbooks" tutorial in the Change Automation Developer Guide on Cisco DevNet.

)

Note While you cannot overwrite a Cisco-supplied Playbook, you can overwrite a custom Playbook. The system
will warn you when you are about to overwrite a custom Playbook but will not prevent you from doing so.
Take precautions to ensure that you do not overwrite your custom Playbooks accidentally.

You cannot re-import an exported Cisco-supplied Playbook with the same name as the original.

Before you begin

To import Playbooks, a user must have write access. For more information about granting a user read-writer
role access, see Configure Change Automation Settings.

Step 1 From the main menu, choose Network Automation > Playbook List.

Step 2 Click . Your browser will prompt you to browse to and select the gzipped archive file containing the Playbooks you
want to import.

Make sure there is no existing Playbook with the same name as the Playbook you intend to import unless you want to
overwrite the existing Playbook.

If you are creating an improved version of a Playbook, it is recommended that you use a version number or other indicator
to ensure that the name is unique and does not overwrite the original Playbook until the replacement is completely tested.

Step 3 Follow the prompts to import the archive file.

Delete Custom Playbooks

You can delete user-defined Playbooks only. You cannot delete a Cisco-supplied Playbook.

Your user ID must have Change Automation delete permission to delete Playbooks.
Step 1 From the main menu, choose Network Automation > Playbooks List.

Step 2 In the Playbooks List window, select the custom Playbook you want to delete.

Step3  Click the (@ icon.
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Step 4 When prompted, click Delete again to confirm.

Assign Playbooks to Specific Roles

Assign Playbooks to Specific Roles .

This section explains how to assign Playbook labels to specific roles so that they can run and import the
Playbooks with that particular label. Admin users can enable other users to run Playbooks with a specific

label.

Before you begin

If required, create a new user to whom you would want to assign the Playbook. For more information, see the
topic Create User Roles in the Cisco Crosswork Network Controller Administration Guide.

Step 1 Go to Administration > Users and Roles> Roles > Playbook.

Step 2 Under the Roles pane, select the role to whom you want to assign the Playbook labels.
Step 3 Enable the Permissions check boxes for the Playbook L abel(s) you want to assign.

Figure 17: Playbook Labels

— Global API Permissions Task Permissions  Playbook

admin Playbook Labels _
Permissions
dummy
Playbook Label No of Playbooks Schedule / Run
testrole I
testrolel
o - e

testrole2 o BE

About Running Playbooks

You must have permission to run the Playbooks with a particular Playbook label. For more information on
assigning Playbooks to specific roles, see Assign Playbooks to Specific Roles, on page 19.

Running any Playbook consists of five steps:

1. Select the Playbook you want to run (see View the Playbook List, on page 3).

Select the device or devices that you want to run it on.

2
3. Enter the appropriate run-time par ameter s that you want the Playbook to apply.
4

Select the execution mode that you want to use:

a. Perform a Dry Run of a Playbook, on page 21, where you can see what the Playbook does before

make changes to the network.

b. Run Playbooks In Single Stepping Mode, on page 27, so you can pause after each Playbook check
or action, and roll back changes you did not intend.
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C. Run Playbooks In Continuous Mode, on page 33 and apply the changes immediately.

While selecting the execution mode, you can also choose to:

* Schedule Playbook Runs, on page 39 for another calendar date or time.

+ Collect syslogsduring and after the run. Syslog collection is available only when running the Playbook
in single-stepping or continuous execution mode and only if you have already configured a syslog
storage provider.

* Specify a Failure Policy, where you decide what the system should do if a failure occurs during the
Playbook run.

5. Confirm your settings and run the Playbook in the execution mode you selected.

Depending on their complexity and network factors, some Playbooks may take much time to run. You can
view the run details and status at any time during and after the completion of a run. If the Playbook is still
running, you can also choose to cancel it. For details, see View or Abort Playbook Jobs, on page 41.

Playbook Execution Order

When it is running, every Playbook conducts checks and configuration changes in four phases, which correspond
to sections of the Playbook code (identified using the tags discussed in Playbook Components and Files, on

page 11):
1. Pre-Maintenance—This phase of the Playbook includes non-disruptive checks and any other operations
on the device that prepare it for potentially traffic-impacting changes. For example:

» Take snapshots of various routing protocol states.
* Take snapshots of memory, CPU, and system health parameters.
* Validate the capacity (storage, memory) on active and standby routers for the new software patch

upgrade.

2. Maintenance—This phase of the Playbook includes any task that may disrupt traffic flowing through the
router or impact neighboring routers. For example:

* Cost out the router and wait until traffic drains out completely.
* Verify that the redundant router is healthy and carrying traffic.
* Perform the upgrade procedure on the device.

» Reconfigure the device(s) to support a new configuration or feature.

3. Post-Maintenance—This phase of the Playbook includes verification tasks to perform on the router after
any disruptive operation. For example:

* Verify that the current state matches the desired state.
* Cost in the router and wait for traffic to return to normal levels.
4. Continuous—In addition to the three serial phases already described, Change Automation can also run

check tasks that span the entire duration of Playbook execution. These tasks check the state of the router
while the Playbook is being deployed and cancel the Playbook execution if any catastrophic or undesirable

. Automate Network Changes



| Automate Network Changes
Perform a Dry Run of a Playbook .

state change occurs. The checks in the Playbook may also monitor a neighboring router to guarantee no
second-order failures in the network while the changes are being deployed.

Perform a Dry Run of a Playbook

A dry run lets you view configuration changes that the Playbook will send to the device without performing
the actual commit of the changes, as you would with a run in the single-stepping or continuous execution
modes.

It is a best practice to perform a dry run and verify the configuration changes before you deploy those changes
to the router. If the dry run fails, you may want to debug its parameter values using another dry run. You can
also debug by performing a single-stepping run, which will allow you to abort and rollback changes after one
or more of the plays, instead of only at the end, as part of a continuous run's Failure Policy.

Note that dry run mode is intended for use only with Playbooks that perform device configuration changes
via Cisco NSO. See the "Playbooks" and "Plays" references in the Change Automation Developer Guide on
Cisco Devnet for details on Playbooks that do not support dry run mode. These will include, for example,
Node state snapshot, Install optional package or SMU, and Uninstall optional package or SMU.

Step 1 From the main menu, choose Network Automation > Run Playbook.

Step 2 In the Available Playbookslist on the left, click on the Playbook you want to dry run. On the right, the window displays
the Playbook name, hardware and software compatibility information, and descriptions for all the plays in the selected
Playbook.

Figure 18: Select Playbook

Select Playbook Select Devices Parameters Execution Polic Confirm

IAva'Iah'e Playbooks | Install a SMU or an optional package on a router
Searct
Last Modif

vare Platform: 10SXR ~ ZVersion: 1.0.0

9-Nov-2022 03

3 AM PST by Cisco

Predefined Playbooks My Playbooks Al Playbooks

Description: Install SMU package on a router

Create/Update VRF configuration on a XE router

Pre Maintenance (1) ~ Maintenance (5) o
Create/update/delete VRF configuration on router

Delete a SMU or an optional package from the SWIM repository. 1 Verify package consistency on route 2Perform DLM node lock on device(s)

Delete ACL based traffic steering configs 3Install upload package(s)
Delete DSCP based traffic steering configs 41nstall add package(s)
Enable/Disable traffic collector 5 Install activate package(s)

[ Install a SMU or an optional package on a router 6 Install commit package(s)

@ int_coll

[@ intint

Post Maintenance (1) 5

Interface State change for XE device

7 Verify package in committed list on router
Interface State change on XR

Node State Snapshot

Prefix Set ADD/DELETE

Sancal m

Step 3 Click Next. The Select Devices window appears.
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Figure 19: Select Devices

Select Playbook

LIST! (O select Device Tag (@) Select Device Manually

Filter By Device(s) Selected @y xrvOk-15-216 X * You must have at least 1 and at most 1 devices

©

City Select From Available Devices (5)° =

O peLey Reachability S...  Operational State Host Name Software Platform Provider Name  Lock Status Unique Identifier
O momo ( < < ) ) ( ) | <] ‘
[ BLR(O)

) masty @ Reachable @Ok xrvek-15-212 10S XR nso101 o Unlock 8e449498-2abc-431b-b9d6-220cc80de49b

[ xoL(0) @ Reachable @OK Xrv9k-15-216 108 XR nso101 & Unlock 9a94dc6b-fboa-dc2d-87b5-059bcdf384fc
See More @ Reachable @ OK(1) ©  xrvok-15-214 108 XR nso101 & Unlock cbd5agbf-05bb-4110-aea0-a548bd846eTa
Default @ Reachable @OK Xrvak-16-211 108 XR nso101 & Unlock 4ab1d9f2-c533-4548-895¢-0d673572116

[ mats) @ Reachable @OK xrvok-15-213 108 XR nso101 & Unlock 4b40b03d-1d5d-4e52-bdc5-78a4318d1d05
[ snmp(s)

[ clits)

[ topo-snmp(5)

[ gnmi(s)

See More

Mm_group

[ intf(3)

Pulse_profile

Using this window:

* You can toggle between the table view and topology map view by clicking and selecting the relevant option on
the drop-down button on the upper left corner of the window. Choose Select Devices From List or Select Devices
From Map to select the table view or topology map view respectively. By default, the table view is displayed.

 With the topology map view displayed, you can toggle between the map's geographical and logical views by

clicking on the © or the . You can also zoom, display bandwidth utilization, and change logical view layouts
as you do with the topology map you see when you select Topology from the main menu.

* You can select the devices manually or using tags. The Select Device Tag option targets you to select the relevant
tag instead of devices from the table and all devices associated with the relevant tag are selected. The Select Device
Manually option allows you to select the devices from the list using quick and advanced filters and filter by tags

on the left. Hover the mouse pointer over the @ icon next to the options for more information. You can also view
the selection criteria, such as the number of devices required for the selected playbook.

Note If you are a non-admin user and selecting the devices manually, make a note of the following:

* The devices on which you want to run the Playbook must belong to a Device Access Group, and you
must have access to this Device Access Group. For more information on Device Access Groups and
associating a user with a Device Access Group, see the Manage Device Access Groups section in the
Cisco Crosswork Network Controller Administration Guide.

* If your role is associated with an empty Device Access Group, then you will receive an error message.

* If your role is associated with multiple Device Access Groups and the device belongs to any of these
Device Access Groups, then you can run the Playbook on this device. If the device does not belong
to any of your Device Access Groups, then the operation fails.

« If you are selecting multiple devices (using Allow Bulk Jobs option or using tags) and if any of the
devices does not have access, then an error message appears stating that this list of devices does not
have access to run the Playbook.

* In the Select Device Manually selection mode, you can check the Allow Bulk Jobs check box to select multiple
devices and run the selected playbook on them simultaneously. Based on your selection, the system creates a static
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group of multiple jobs. Hover the mouse pointer over the @ icon next to the check box for more information.
There is no limit to the number of devices you can select for a bulk job.

Note Allow Bulk Jobsoption is enabled for playbooks that can be executed on a single device.

Step 4 Click Next. The Parameters window appears.
Step 5 In the fields provided in the Parameter s window, enter the Playbook parameter values for this dry run.

Figure 20: Parameters

Select Playbook Select Devices Parameters Execution Po; Contirm

v Install a SMU or an optional package on a router B}

\/ Verify package consistency on router @ ]

collection_type

/' Perform DLM node lock on device(s) @ E]

retry_count

Number of time node lock wil be retried

retry_interval

Time interval between subsequent retries for node lock. e.g. 10s, m, etc. Valid time units are 'ns', 'us’, 'ms’, 's’, 'm, "h

v Upload package(s) to the SWIM Repository @ [E]

v packages @

With the Parameter s window displayed, you can also:
* Click (=Jto upload a JSON file with the parameter values you want. You will be prompted to navigate to the JSSON
parameters file you have previously prepared (or downloaded from a previous Playbook run) and then upload it

as appropriate for your browser and operating system.

* Click K2 to enter the parameter values in JSON format. A popup text window displays the full list of JSON
parameters with empty values in quotes. Edit the values, and when you are finished, click Save.
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Figure 21: Edit JSON

Vv Install a SMU or an optional package on a router B

a
Vv Verify package consistency on router @ B (]
collection_type
nat
v
Data collection type
74

v Perform DLM node lock on device(s) @ B )

retry_count
3

Number of time node lock wil be retried

retry_interval

Time interval between subsequent retries for node lock. e.g. 10s, m, etc. Valid time units are 'ns;, 'us, 'ms, s, 'm’

* Click Ej to select the items you want to configure. A pop-up text window will appear, displaying the complete
list of plays or parameters that can be configured. For the Playbook, it will show a list of Plays and, for each
selected Play, it will display a list of parameters that can be configured for that Play. If you unselect any item, it
will not appear for configuration. Uneditable options indicate mandatory items that cannot be deselected.

Figure 22: Object Properties for a Playbook

Vv Install a SMU or an optional package on a router B

Verify package consistency on &
\/ Verify package consistency on router @ Brouter
Perform DLM node lock on
. Fdevice(s)
collection_type Upload package(s) to the SWIM
— Repository
Finstall add package(s) A4

Data collection type Pl »

v Perform DLM node lock on device(s) @ B

retry_count
3

Number of time node lock will be retried

retry_interval

ss

Time interval between subsequent retries for node lock. e.g. 10s, 1m, etc. Valid time units are s’ 'us’, 'ms, 's, 'm;, "
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Figure 23: Object Properties for a Play
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Vv Verify package consistency on router @ B

collection_type
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Perform a Dry Run of a Playbook .

« Click ® to add additional instances of a particular parameter, if required for the Playbook you are running. Click

W to delete instances added in this way.

* Click to clear all the parameter values entered so far.

a.

Step 6 With the parameter values set, click Next. The Execution Policy window appears.

Figure 24: Execution Policy

4 e}
Select Playbook Select Devices Parameters Execution Policy Confirm
Execution Mode
Continuous Single Stepping Dry Run
Run the playbook without interruption. Run the Playbook one play at a time, and iew the configuration changes withou
:: ” ’ ..__ specify Whey"“’ "3“5‘: ’ V) — \:Ioerfur:\‘mg a’cgommit panges vt
ot [ V) —
o= @ e—
Step 7 Choose Dry Run and click Next. The Review your Job window appears, displaying a summary of your choices:

playbook, devices, parameters, and execution policy.
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Figure 25: Review your Job
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In this window:
* You must provide a relevant Name for the job.
* You can enter labels for your job using the L abels field.

* You can click on any Change links in the Review your Job window summary to modify your choices.

Step 8 (Optional) Enter the device credentials (name and password).

Note This step is applicable only if Credential Prompt is enabled in the Change Automation settings. For more
information, see Configure Change Automation Settings.

Step 9 When you are ready to continue, click Run Playbook.
Step 10 At the confirmation prompt, click Confirm. The Execution Mode window is displayed.
Step 11 After the dry run is complete:

* Click the Dry Run tab and verify the configuration changes that would be pushed to the device had this not been
a dry run. This tab will display ano config change message if no changes have been made. Please note that
this tab shows only cumulative configuration changes, not each individual change made. For example, if a Playbook
configures set-overload-bit in one step and then unconfigures it using no set-overload-bit later, the tab will
show no config change.

* Click the Eventstab to see success and failure messages for each step of the Playbook. This can help you diagnose
and correct problems with individual plays and the run as a whole. For troubleshooting information, see Troubleshoot
Change Automation, on page 44.

* Click the Consoletab to see messages that are generated during the run.

As syslog collection is disabled for dry run, the Syslog tab will contain only a message stating that.
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Step 12 (Optional) If you want to perform a single-step debugging run, or are ready to commit the changes to the device, click
Execute Now. The Execution Policy window will display all of your parameter values from the dry run.

Run Playbooks In Single Stepping Mode

Single-stepping execution mode is a handy way to test a custom or modified Playbook or diagnose problems
with a pre-packaged Playbook that does not give you the desired results. Unlike a dry run, a single-stepping
execution commits configuration changes to the device as the Playbook runs. However, you can set breakpoints
on or pauses after any Maintenance or Post-Maintenance action in the Playbook. Note that while you can set
breakpoints on Pre-Maintenance actions, doing so will have no effect, and these actions will not pause.

Whenever the Playbook hits a breakpoint, it will stop and will not continue until you issue the command to
proceed. At each pause, you can also abort the entire run and roll back all changes made or roll back to any
previous play.

Step 1 From the main menu, choose Network Automation > Run Playbook.

Step 2 In the Available Playbooks list on the left, click on the Playbook you want to run. On the right, the window displays
the Playbook name, hardware and software compatibility information, and descriptions for all the plays in the selected
Playbook.

Figure 26: Select Playbook
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Interface State change on XR
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Step 3 Click Next. The Select Devices window appears.
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Figure 27: Select Devices
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Using this window:

* You can toggle between the table view and topology map view by clicking and selecting the relevant option on
the drop-down button in the upper left corner of the window. Choose Select Devices From List or Select Devices
From Map to select the table view or topology map view, respectively. By default, the table view is displayed.

 With the topology map view displayed, you can toggle between the map's geographical and logical views by

clicking on the © or the . You can also zoom, display bandwidth utilization, and change logical view layouts
as you do with the topology map you see when you select Topology from the main menu.

* You can select the devices manually or using tags. The Select Device Tag option targets you to select the relevant
tag instead of devices from the table and all devices associated with the relevant tag are selected. The Select Device
Manually option allows you to select the devices from the list using quick and advanced filters and filter by tags

on the left. Hover the mouse pointer over the @ icon next to the options for more information. You can also view
the selection criteria, such as the number of devices required for the selected playbook.

Note If you are a non-admin user and selecting the devices manually, make a note of the following:

* The devices on which you want to run the Playbook must belong to a Device Access Group, and you
must have access to this Device Access Group. For more information on Device Access Groups and
associating a user with a Device Access Group, see the Manage Device Access Groups section in the
Cisco Crosswork Network Controller Administration Guide.

* If your role is associated with an empty Device Access Group, you will receive an error message.

* If your role is associated with multiple Device Access Groups and the device belongs to any of these
Device Access Groups, then you can run the Playbook on this device. The operation fails if the device
does not belong to any of your Device Access Groups.

« If you select multiple devices (using the Allow Bulk Jobs option or using tags) and if any of them
does not have access, an error message appears stating that this list of devices does not have access
to run the Playbook.

* In the Select Device Manually selection mode, you can check the Allow Bulk Jobs check box to select multiple
devices and run the selected playbook on them simultaneously. Based on your selection, the system creates a static
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group of multiple jobs. Hover the mouse pointer over the @ icon next to the check box for more information.
There is no limit to the number of devices you can select for a bulk job.

Note Allow Bulk Jobsoption is enabled for playbooks that can be executed on a single device.

Step 4 Click Next. The Parameters window appears.
Step 5 In the fields provided in the Parameter s window, enter the Playbook parameter values for this run.

Figure 28: Parameters

Select Playbook Select Devices Parameters Execution Po; Contirm

v Install a SMU or an optional package on a router B}

\/ Verify package consistency on router @ ]

collection_type

/' Perform DLM node lock on device(s) @ E]

retry_count

Number of time node lock wil be retried

retry_interval

Time interval between subsequent retries for node lock. e.g. 10s, m, etc. Valid time units are 'ns', 'us’, 'ms’, 's’, 'm, "h

v Upload package(s) to the SWIM Repository @ [E]

v packages @

With the Parameter s window displayed, you can also:
* Click (=Jto upload a JSON file with the parameter values you want. You will be prompted to navigate to the JSSON
parameters file you have previously prepared (or downloaded from a previous Playbook run) and then upload it

as appropriate for your browser and operating system.

* Click K2 to enter the parameter values in JSON format. A popup text window displays the full list of JSON
parameters with empty values in quotes. Edit the values, and when you are finished, click Save.
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Figure 29: Edit JSON

Vv Install a SMU or an optional package on a router B

a
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collection_type
nat
v
Data collection type
74

v Perform DLM node lock on device(s) @ B )

retry_count
3

Number of time node lock wil be retried

retry_interval

Time interval between subsequent retries for node lock. e.g. 10s, m, etc. Valid time units are 'ns;, 'us, 'ms, s, 'm’

* Click Ej to select the items you want to configure. A pop-up text window will appear, displaying the complete
list of plays or parameters that can be configured. For the Playbook, it will show a list of Plays and, for each
selected Play, it will display a list of parameters that can be configured for that Play. If you unselect any item, it
will not appear for configuration. Uneditable options indicate mandatory items that cannot be deselected.

Figure 30: Object Properties for a Playbook
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Figure 31: Object Properties for a Play
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« Click ® to add additional instances of a particular parameter, if required for the Playbook you are running. Click

W to delete instances added in this way.
* Click to clear all the parameter values entered so far.

Step 6 With the parameter values set, click Next. The Execution Policy window appears.
Step 7 Choose Single Stepping. The Execution Policy window displays additional features to customize the job:

Figure 32: Execution Policy

Select Playbook Select Devices Parameters Execution Policy Confirm
Execution Mode
Continuous Single Stepping Dry Run
Run the playbook without nterruption. Run the Playbook one play at 2 time, and View the configuration changes without

O — o= speciy when to pause. / == performing a commit,

o— o= V —

O’ o 0 —

o=
Collect Syslog © Failure policy © Timeout © Single stepping breakpoints
Oves @ o on failure Abort | [ (3s00 Pause after [Every step
Schedule All Scheduled Jobs Show jobs for selected 0
devices only
Run Now Previous  Today ~ Next November 2023 Week  Day
Sunday Monday Tuesday Wednesday Thursday Friday Saturday
1
(10
1)
1 4
1
20 1 2 2

() D

* Under Collect Sydlog, click Yesif you want syslogs to be collected during and immediately after the run and No
if you do not. Yesis the default selection only if you have a syslog provider configured.

* From the Failure Policy dropdown, select:

* Abort to abort the entire run without rolling back any changes, if a failure occurs at any point. This is the
default. Any configuration changes made up to the point of failure will not be rolled back.
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Step 8

Step 9

Step 10

Step 11
Step 12

Step 13

* Pause to pause the run and allow you to decide how to handle the failure. This pause will be in addition to
any breakpoints you set using the Single stepping breakpoints dropdown.

» Complete Roll Back to abort the entire run and roll back all configuration changes made.

* In the Schedule area, uncheck the default Run Now selection to schedule the job for a later time. See Schedule
Playbook Runs, on page 39 for help on using the Schedule area features.

From the Single stepping breakpoints dropdown, select either

» Every step to pause automatically after every step in the Playbook.
* Customize to select the steps where you want the Playbook to pause.

If you select Customize, the Customize Check Point pop-up displays a list of all the plays in the Playbook, with a

@at the step between each play. Click the O, at each step where you want to set a breakpoint. When you are finished,
click Done.

Click Next. The Review your Job window appears, displaying a summary of your choices: playbook, devices, parameters,
and execution policy. In this window:

* You must provide a relevant Name for the job.
* You can enter labels for your job using the L abels field.

* You can click on any Change links in the Review your Job window summary to modify your choices.

(Optional) Enter the device credentials (name and password).

Note This step is applicable only if Credential Prompt is enabled in the Change Automation settings. For more
information, see Configure Change Automation Settings.

When you are ready to continue, click Run Playbook.

At the confirmation prompt, click Confirm. Click View Job Set to view the status of the current job. The job details
include job status, job set tags, the title of the selected playbook, execution parameters and policy, last updated date,
and updated comments (if any).

While the run is executing, the Running tile at the top of the window will change to Paused for each step at which
you have set a breakpoint. Your choices at each pause will be displayed as buttons below the tiles:

* Click Resume to resume running from this point, with no changes. The Resume request includes the runtime
parameters from the previous step; you can edit these, as needed, later.
* Click Roll Back to roll back any changes made so far. You can choose how far to rollback:

* Click Complete Roll Back to roll back all changes to the start of the Playbook run. Once you have rolled
back to the start, you can choose to Resume from that point, Abort the run entirely, or Edit runtime
parameters of the run.

» Click Select Roll Back Point to roll back changes to your selected step. All the previous steps will have a
roll back point icon next to them. Click this icon for the step to which you want to roll back. Once you have
selected the step, you can choose to Resume from that step, Roll Back further, Abort the run entirely or Edit
runtime parameters.

* Click Abort to abort the run entirely. No changes made will be rolled back.
* Click Edit runtime parametersto edit the parameters the run is using. You edit using a pop-up version of the
Parameter s window, just as you did in step 6. When resuming, the parameters exposed for editing are specific
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to the task being resumed, meaning they are not the same global parameters you defined in step 6. Most of the
time, they are a subset of the global parameters. When you are finished, click Apply. You can then choose to
Resume execution with the changed parameters.

Step 14 While the run is executing, you can also use the following features of the progress window:

* View the execution status of each play in the Playbook in the M aintenance play list at the left side of the window.
Plays that fail are indicated with a red icon; plays that succeed are indicated with a green icon.

* See reminders of your choices in the Playbook and Devicestiles at the top of the window.
* See the current status of the run in the Running tile at the top of the window.

* Click View in the Parameter stile to view the run's parameters. While viewing the parameters, you can click
Download Parameter sto save them in a JSON file. You will be prompted to name and save the file appropriately
for your browser and operating system.

+ Use the network topology in the map at the right side of the window to view the device and its connections to the
rest of your network.

Step 15 After the run is complete:

* Click the Eventstab to see success and failure messages for each step of the Playbook. This can help you diagnose
and correct problems with individual plays and the run as a whole.

* Click the Syslog tab to access syslog messages collected during and immediately after the run. If syslog collection
is enabled, the tab will provide a pointer to the path on the syslog storage provider where collected syslogs are
stored. If you chose not to collect syslogs, or no syslog storage provider has been configured, this tab will display
a message indicating that syslog collection is disabled.

* Click the Console tab to see relevant commands and responses from the device consoles that took place during
the run. These messages can also help with diagnostics.

* An event is created in the audit log (Administration > Audit L og). The audit log includes details like the name
of the Playbook, the user who ran the Playbook, and the commit label, if present.

Run Playbooks In Continuous Mode

Continuous execution mode is the standard way to run Playbooks. Configuration changes are committed to
the device during the run, with no checks or delays except those programmed for system resets or other
purposes. The run continues until it succeeds or fails. If it fails, you can use the run's Failure Policy to abort,
rollback all changes made to the device, or pause execution at the failure point.

It is always good practice to perform a dry run and verify the configuration changes before committing to a
continuous run (see Perform a Dry Run of a Playbook, on page 21). You can also run the Playbook in
single-stepping mode, which will allow you to pause execution after any play you select, abort and rollback
changes as needed, and even change runtime parameters in the middle of the run (see Run Playbooks In Single
Stepping Mode, on page 27).

Step 1 From the main menu, choose Network Automation > Run Playbook.
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Step 2

Step 3
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In the Available Playbooks list on the left, click on the Playbook you want to run. On the right, the window displays
the Playbook name, hardware and software compatibility information, and descriptions for all the plays in the selected

Playbook.
Figure 33: Select Playbook
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Click Next. The Select Devices window appears.

Figure 34: Select Devices
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* You can toggle between the table view and topology map view by clicking and selecting the relevant option in
the drop-down button on the upper left corner of the window. Choose Select Devices From List or Select Devices
From Map to select the table view or topology map view, respectively. By default, the table view is displayed.
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» With the topology map view displayed, you can toggle between the map's geographical and logical views by
clicking on the © or the . You can also zoom, display bandwidth utilization, and change logical view layouts
as you do with the topology map you see when you select Topology from the main menu.

* You can select the devices manually or using tags. The Select Device Tag option targets you to select the relevant
tag instead of devices from the table and all devices associated with the relevant tag are selected. The Select Device
Manually option allows you to select the devices from the list using quick and advanced filters and filter by tags

on the left. Hover the mouse pointer over the @ icon next to the options for more information. You can also view
the selection criteria such as number of devices required for the selected playbook.

Note If you are a non-admin user and selecting the devices manually, make a note of the following:

* The devices on which you want to run the Playbook must belong to a Device Access Group and you
must have access to this Device Access Group. For more information on Device Access Groups and
associating a user with a Device Access Group, see the Manage Device Access Groups section in the
Cisco Crosswork Network Controller Administration Guide.

* If your role is associated with an empty Device Access Group, you will receive an error message.

« If your role is associated with multiple Device Access Groups and if the device belongs to any one
of these Device Access Groups, then you can run the Playbook on this device. If the device does not
belong to any of your Device Access Groups, the operation fails.

« If you are selecting multiple devices (using Allow Bulk Jobs option or using tags) and if any devices
does not have access, an error message appears stating that this list of devices does not have access
to run the Playbook.

* In the Select Device Manually selection mode, you can check the Allow Bulk Jobs check box to select multiple
devices and run the selected playbook simultaneously. Based on your selection, the system creates a static group

of multiple jobs. Hover the mouse pointer over the @ icon next to the check box for more information. There is
no limit to the number of devices you can select for a bulk job.

Note Allow Bulk Jobsoption is enabled for playbooks that can be executed on a single device.

Step 4 Click Next. The Parameters window appears.
Step 5 In the fields provided in the Parameter s window, enter the Playbook parameter values to use for this run.
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Figure 35: Parameters
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With the Parameter s window displayed, you can also:

* Click (=Jto upload a JSON file with the parameter values you want. You will be prompted to navigate to the JSON
parameters file you have previously prepared (or downloaded from a previous Playbook run) and then upload it
as appropriate for your browser and operating system.

* Click K2 to enter the parameter values in JSON format. A popup text window displays the full list of JSON
parameters with empty values in quotes. Edit the values, and when you are finished, click Save.

Figure 36: Edit JSON
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* Click i to select the items you want to configure. A pop-up text window will appear, displaying the complete
list of plays or parameters that can be configured. For the Playbook, it will show a list of Plays and, for each
selected Play, it will display a list of parameters that can be configured for that Play. If you unselect any item, it
will not appear for configuration. Uneditable options indicate mandatory items that cannot be deselected.
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Figure 37: Object Properties for a Playbook
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Figure 38: Object Properties for a Play
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« Click @ to add additional instances of a particular parameter, if required for the Playbook you are running. Click
W to delete instances added in this way.

* Click to clear all the parameter values entered so far.

Step 6 With the parameter values set, click Next. The Execution Policy window appears.
Step 7 Choose Continuous. The Execution Policy window displays additional features to customize the job:
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. Run Playbooks In Continuous Mode

Step 8

Step 9

Step 10

Figure 39: Execution Policy

Select Playbook Select Devices Parameters Execution Policy Confirm

Execution Mode
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single Stepping

View the configuration changes without

Run the playbock without interruption. ]
o V) — performing a commit.
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Oves @ no On failure Abort | [ 3600
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All Scheduled Jobs devices only

Run Now (] Previous | Today | Next October 2023 Week | Day

Schedule Pre-check (ATericalLos_Angeles)(D) Sunday Vonday Tuesday Wednesday Thursday Friday Saturday
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2023-10-31 gd date

aIncrement hours alncrement minutes

~ Decrement hours ~ Decrement minutes

* Under Collect Syslog, click Yesif you want syslogs to be collected during and immediately after the run, and No
if you do not. Yesis the default selection only if you have a syslog provider configured.
* From the Failure Policy dropdown, select:

* Abort to abort the entire run without rolling back any changes, if a failure occurs at any point. This is the
default. Any configuration changes made up to the point of failure will not be rolled back.

* Pause to pause the run and allow you to decide how to handle the failure.
» Complete Roll Back to abort the entire run and roll back all configuration changes made.

« In the Schedule area, uncheck the default Run Now selection to schedule the job for a later time. See Schedule
Playbook Runs, on page 39 for help on using the Schedule area features.

Click Next. The Review your Job window appears, displaying a summary of your choices: playbook, devices, parameters,
and execution policy. In this window:

* You must provide a relevant Name for the job.
* You can enter labels for your job using the L abels field.

* You can click on the Change links in the Review your Job window summary to modify your choices.

(Optional) Enter the device credentials (name and password).

Note This step is applicable only if Credential Prompt is enabled in the Change Automation settings. For more
information, see Configure Change Automation Settings.

When you are ready to continue, click Run Playbook.
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Step 11 At the confirmation prompt, click Confirm. Click View Job Set to view the status of the current job. The job details
include information such as job status, job set tags, the title of the selected playbook, execution parameters, and policy,
last updated date, and update comments (if any).

Step 12 While the run is executing, the Running tile at the top of the window will change to Paused if you chose a Failure
Policy of Pause. Your choices will be displayed as buttons below the tiles:

* Click Resume to resume running from this point, with no changes.
* Click Roll Back to roll back any changes made so far.
* Click Abort to abort the run entirely. No changes made will be rolled back.

Step 13 While the run is executing, you can also use the following features of the progress window:

* View the execution status of each play in the Playbook in the M aintenance play list at the left side of the window.
Plays that fail are indicated with a red icon; plays that succeed are indicated with a green icon.

* See reminders of your choices in the Playbook and Devicestiles at the top of the window.
* See the current status of the run in the Running tile at the top of the window.

* Click View in the Parameter stile to view the run's parameters. While viewing the parameters, you can click
Download Par ameter sto save them in a JSON file. You will be prompted to name and save the file as appropriate
for your browser and operating system.

* Use the network topology in the map at the right side of the window to view the device and its connections to the
rest of your network.

Step 14 After the run is complete:

* Click the Eventstab to see success and failure messages for each step of the Playbook. This can help you diagnose
and correct problems with individual plays and the run as a whole.

* Click the Syslog tab to access syslog messages collected during and immediately after the run. If syslog collection
is enabled, the tab will provide a pointer to the path on the syslog storage provider where collected syslogs are
stored. If you chose not to collect syslogs, or no syslog storage provider has been configured, this tab will display
a message indicating that syslog collection is disabled.

* Click the Console tab to see relevant commands and responses from the device consoles that took place during
the run. These messages can also help with diagnostics.

* An event is created in the audit log (Administration > Audit L og). The audit log includes details like the name
of the Playbook, the user who ran the Playbook, and the commit label, if present.

Schedule Playbook Runs

The Change Automation application's Execution M ode window allows you to schedule future Playbook runs
as jobs and view all the jobs that have been scheduled. Use the Schedule area on the left to schedule a job.
Use the All Scheduled Jobs area on the right to view scheduled jobs on the calendar.
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Note

)

Playbook Job Scheduling is only available if enabled when Change Automation was installed and initially
configured. For more information, see Configure Change Automation Settings. To change this setting, you
must uninstall and then reinstall Change Automation.

Note

If you are a non-admin user, ensure you have access to the Schedule Playbook task. You cannot schedule
playbooks without this task.

Prerequisites:

Ensure that Playbook Job Scheduling is enabled on the Device Override Credentials page. For more
information, see Configure Change Automation Settings.

To enable the task permission, do the following:
1. Go to Administration > Usersand Roles> Roles.
2. Under the Roles pane, select the role for which you want to grant the access.

3. Under the Task Permissions tab, enable the Schedule Playbook check box and click Save.

The Execution M ode window's scheduling features are only displayed when you have chosen to run a Playbook
in continuous or single-stepping mode. You cannot schedule a dry run of a Playbook.

Figure 40: Execution Mode Scheduling Features

Schedule Pre-check (Asia/Calcutta)(2)
2023-11-14 Add date

Increment hours Increment minutes
v Decrement hours v Decrement minutes

Schedule Perform (AsiiCalcuttal (D)
2023-11-14 Add date.

Tuesday

Wednesday

Schildule s i
All Scheduled Jobs d:m: elsol;: I!:r selected
Run Now O vious ay X October 2023 Monm Week Day
© L

Playbook Job Sets

Job Sets
@snap-12d9857906

Start Time
16:47

X

lncrement hours Increment minutes (2]
= = o
) - Ire}
v Decrement hours v Decrement minutes ™
N
[Te}
Item Description
1 Run Now: Running Playbooks immediately is the default for continuous and single-stepping

execution modes. To schedule a run for a future time and date, you must uncheck this box.

Schedule Selectors: Use these fields to select the future time and date when the Playbook
runs. Although it is the default for the Pre-Maintenance and Maintenance phases of a
scheduled Playbook to start simultaneously, you can use the upper Schedule Pre-check and
lower Schedule Perform fields to schedule the start of Pre-Maintenance and the start of
Maintenance independently. The Schedule Perform time must always be greater than or
equal to the Schedule Pre-check time.
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Item Description

3 Previous/Today/Next Selectors: Use these three selectors with the M onth/Week/Day
selectors to focus the calendar's display of scheduled jobs on the time range in which you

are interested. For example: To show only those jobs scheduled for next week, click Next
and Week.

4 Job I cons: Red, numbered icons in the squares representing each calendar date show how
many jobs are scheduled for that date. Yellow circle icons represent each scheduled job.

5 Job Details pop-up: Hover your mouse cursor over a yellow circle icon to see the details
for the scheduled job represented by that icon. The pop-up shows the execution ID of the
job and the name of the Playbook to be run.

6 Show jobsfor selected devicesonly: Check this box to restrict the calendar display to only
jobs scheduled to run on the devices you have already selected. This is a handy way to see
if the schedule you plan for your Playbook run conflicts with other scheduled jobs on the
same devices.

7 M onth/Week/Day Selectors: Use these three selectors with the Previous/Today/Next
selectors to focus the calendar's display of scheduled jobs on the time range in which you
are interested. For example: To show only those jobs scheduled for last month, click L ast
and Month.

\}

Note Change Automation Playbooks have a mop_timeout parameter, which is a user-specified input needed to
schedule any Playbook.

If you are scheduling a Playbook with Failure Policy set to Complete Roll Back, first dry run the Play
and note the time taken. Then, add a buffer time (for example, 10 minutes) to the time taken during the dry
run. After that, double the time value and enter it to the mop_timeout parameter, as it can take as much
time to roll back the Playbook as it takes to run it until the last step. Without sufficient mop_timeout, the
Playbook can end up incomplete (in between transitions) if the timeout gets triggered while rollback is in
progress. If this happens, you have to revert the changes manually or create a Playbook with the changes you
want to revert.

View or Abort Playbook Jobs

The Automation Job History window lets you click on any individual job in the list to see that job's detailed
execution progress panel. This panel displays the name of the Playbook, its plays, the devices it ran on, the
parameters used, and all events, Syslog, console, and other messages. These details are helpful when diagnosing
failures.

The Automation Job History window also allows you to abort running jobs.

You can also navigate to Automation Job History window from the Jobs panel in the Change Automation
Dashboard.
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Before you begin

Automate Network Changes |

A user must have the permission for specific Playbook label to run or abort a Playbook. For more information
on assigning Playbooks to specific roles, see Assign Playbooks to Specific Roles, on page 19.

Step 1 From the main menu, select Network Automation > Automation Job History. The Automation Job History window
displays a list of Job Sets.

Figure 41: Automation Job History
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The list in Automation Job History window is sorted by the last update time, with running or most recently executed
jobs at the top. You can apply quick or advanced filters to the table as you would with columns in other table windows.

Step 2 To view information about a Playbook job, click the relevant job ID checkbox on the left. The job's status and execution
details are displayed on the right side. Click on the @ icon next to each detail to get more information about the selected
job set.

Step 3 You can abort a job set in running, paused or scheduled status, as follows:

» To abort a specific job, click the check box next to it and then click Abort Selected.
* To abort all jobs immediately, click Abort All.

When prompted, click Confirm. Jobs currently running, paused, or scheduled will abort once the current task has been

completed.

Use the Change Automation Dashboard

The Change Automation Dashboard window (shown in the figure below) lets you view all Playbook-related
activity and initiate Playbook runs. It displays the total number of Playbooks, the Playbook Jobs Calendar,

the most recently run Playbook jobs, and the same network topology map you see when you select Topology
from the main menu.

To view the Change Automation Dashboard window, select Networ k Automation > Dashboard.
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Figure 42: Change Automation Dashboard Window
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The Playbooks tile displays the total number of Playbooks (pre-defined and custom). Clicking on a specific
number displays all the Playbooks that correspond to the selected category:

« Total Playbooks indicate the total number of pre-defined and user-created Playbooks (My Playbooks)
in the system.

* Predefined Playbooks indicate the number of pre-defined Playbooks that exist in the system.

» My Playbooks indicate the number of custom Playbooks created by the current user.

Creating Playbooks does not use a license. The license count is incremented only upon the first execution of

a Playbook (pre-defined or user-created), irrespective of whether the Playbook runs successfully. Subsequent
execution of the Playbook does not increment the license count.

The Jobs Calendar tile displays a calendar (month, week, day) with the number of job sets executed on a
given day marked in a circle against the corresponding date. Clicking on the number displays a dialog box

with the names of the Playbook job sets and their execution time. Click the desired job set to view the execution
details.

The color of the circle indicates the overall status of the job sets:
* A red circle indicates at least one job set with Failed status among the day's overall job sets.
* A gray circle indicates that all job sets are in Scheduled or Running status.
* A bluecircle indicates at least one critical job set in Recovered status among the day's overall job sets.

* A green circle indicates most of the Playbooks are in success state. Clicking on it displays all the jobs
that are Recovered, Scheduled, or Running.

The View All Jobslink on the Jobstile gives you direct access to the Change Automation Automation Job
History window.
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Troubleshoot Change Automation

The following table describes issues you may encounter when using the Change Automation application and

their solutions or workarounds.

Table 1: Change Automation Troubleshooting

Issue

Solution

Playbook run fails with messages indicating that Cisco
Network Services Orchestrator (Cisco NSO) and the
target device are out of sync or communication.
Message text varies but may include "device out of
sync," "NC client timeout," and other text indicating
connectivity or sync issues between Cisco NSO and
the device.

Ensure that the Playbook does not include a sync
operation. Get the device and Cisco NSO back in sync,
and then re-run the Playbook.

Alternatively, you can create a new Playbook that
includes a sync operation to avoid future problems.

Playbook run fails with "access error" messages
indicating failure "to set device override credentials
in NSO".

Ensure that "admin" is a member of the ncsadmin
user group in Cisco NSO.

"Failed to end NSO transaction,
500:fatal: YClientError: Failed to send RPC:" error
is displayed while running the playbook.

Include the below settings in the Cisco NSO
configuration file (ncs. conf):

<ssh>
<client-alive-interval>infinity</client-alive-interval>|

<client-alive-count-max>5</client-alive-count-max:
</ssh>

Note This configuration could increase the load
on Cisco NSO, so it is better to do it only

when necessary.

Playbook aborted due to failure in locking the device
nodes.

In the Devices window, select the relevant devices
and clear the lock by moving the device to DOWN
and then UP. Go to Administration > Crosswork
Manager, click the Change Automation tile, and
restart the robot-nca process. Once the protocols are
reachable, you can schedule to run a new playbook.

SMU install fails at "Verify package in committed
list on router".

Instead of using the tar.gz file in the packages field
under Verify package in the committed list on router
sub-option, use the committed package name to verify
the package.
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